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Basics of MAXScript

In this tutorial you will learn the fundamentals 
of MAXScripting through three different scripts 
that will help you be more efficient when 
working in 3ds Max. Let’s start with the tools we 
are going to use to create our MAXScripts: the 
MAXScript Editor and the MAXScript Listener.

 

Figure 1 – MAXScript Listener. Use the top window to type 
scripts to evaluate, the bottom window also works to type 
scripts but it’s used to display results

The MAXScript Editor can be opened by going to 
MAXScript Menu > MAXScript Editor.

 

Figure 2 – The MAXScript Editor can be opened through the 
MAXScript Menu
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This will start the MAXScript Editor with a new 
empty tab, or with the last scripts you had open 
the last time you closed Max. You will use this 
to create your scripts. It gives you the power to 
test your script while you are writing it and gives 
you visual clues on your syntax and how your 
code is structured.

 

The MAXScript Editor helps on debugging 
(trouble shooting your code) giving you the 
ability to display line numbers.

You can see how Comments are displayed 
green 

Strings are shown in purple 

Integers use teal 

Reserved words or words used in script as part 
of calls or expressions are dark blue or light 
blue

Object sets are highlighted tan

Globals or Max System data will be red

Figure 3 – MAXScript Editor uses color highlighting

The MAXScript Listener can be used to type 
and run commands like the Editor but this is 
only used for one of two lines of code, and also 
to record commands that are run when we do 
things in Max. To open, just go to the MAXScript 
Menu > MAXScript Listener.

NOTE: 
MAXScript evaluates each line one at a time, so make sure if 
you are typing a command it’s all in the same line and don’t 
add carriage returns (do not hit the ENTER key) in the middle 
of the command syntax breaking up the command.

Recording the expression or calls is done by 
enabling the MacroRecorder functionality of the 
MAXScript Listener window.

 

Figure 4 – Enable MacroRecorder if you want to see what expressions 
or calls are happening while you work in Max
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Other useful tools to develop MAXScripts are 
the MAXScript Reference Guide (from Main 
Window go to Help > MAXScript Reference, 
or Help menu from Script Editor or Listener) 
and the internet. Search for pieces of scripts or 
code others have created and try to understand 
how the script works. Learn how to break down 
the code and then build your scripts from this 
knowledge. Some helpful sites are the Autodesk 
AREA Network, ScriptSpot.com and Highend3d.
com 

Basic Elements of Scripting

In the last section, you learned about the tools 
you will use to create your scripts. Now we 
are going to jump right into scripting, writing 
your first sniped of code, and running your first 
MAXScript.

First Thing… Label Your Script

You will need to get into the habit of 
commenting as much as you can. This means 
you insert lines in your code that are not 
evaluated (executed as part of the code) but 
just have comments of what you are doing or 
defining at that point. MAXScript uses two 
dashes (--) as a comment tag. So, you will use 
this to create a label for your script. Once you 
come up with something you like, you can just 
copy/paste it into all your scripts. This is how 
you will start your script.

Your First Script… GreyShader

Open a new window in the MAXScript Editor by 
going to File > New. You will get a new empty 
tab where you will start creating your script. 
Now type in your label as a comment like this:

------------------------------------------------------------------------------------------------
-- CD_GreyShader.ms
-- created 12.03.08
-- by Carlos Dominguez 
-- DESCRIPTION: Simple script to cover basics of: variables, loops, functions
-- 
------------------------------------------------------------------------------------------------

1.
2.
3.
4.
5.
6.
7.
8.

NOTE: 
Every time I show you example code, I will frame it in a table 
and use an Italic font so you can differentiate between code 
and the written tutorial. I will also use the color highlight 
syntax used in the MAXScript Editor.
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Let’s break these lines of code:

•	 Line 1 and 7 are just used to create a 
frame for the label. Just like the other 5 
lines, you start the line with two dashes 
(--) so it’s a comment line.

•	 Line 2 is what you will name your script 
when saved. We will save this script in 
a moment and that is the name you will 
use to save your script. 

•	 Line 3 notes the creation date

•	 Line 4 is the author of the script. 
Sometimes the author is different than 
the owner so you will want to always 
include this.

•	 Line 5 is the description of the script so 
anyone can open the script and know 
what it is for and what it can do.

NOTE: 
The name starts with CD, my initials (Carlos Dominguez), 
so use your initials at this point. If this was a script for High 
Moon Studios you would start the name with HMS. When 
you name script, it’s a good practice to use Camel Case. 
Camel Case is when you type multiple words together and 
you always make the first letter of each word Upper Case. So 
instead of typing Grey shader you will type GreyShader. You 
will use the underscore (_) when you want to separate dif-
ferent parts of the name, like who is the owner of the script, 
then the name of the script, and finally the version of the 
script (i.e.: CD_ScriptName_1)

Save your Script by going to File > Save 

Remember to use the same name as you put 
in your label (CD_GreyShader.ms for mine) 
and pick either the default directory, or make a 
directory where you will keep all your scripts.

Declaring Variables

The next thing you want to do is declare your 
variables. Variables are like boxes that hold 
information for you until you need it, and they 
can be Local (it only exists inside that function) 
or Global (exists everywhere in Max until 
you close the script). This is the Scope of the 
Variable. You need to give variables a name that 
makes sense, a name that can tell you what 
the content is. It is always good practice to use 
Camel Case format and always start the name 
with a lower case letter.

The information inside the variable can be of 
different types, and based on the function or 
execution you may need a specific type. Some of 
the data types are:

•	 String: any text, including numbers and 
symbols

•	 Integer: holds numbers with no 
decimals (not 1.5 or 2.756, just 1 or 2, 
etc.)

•	 Float: numbers with decimals (i.e. 
2.756, 3.1416, etc.)

•	 Boolean: just holds True (or 1) or False 
(or 0)

To declare a variable all you have to do is type 
your variable name, the equal sign (=), and the 
value you want. For example:
	 myVar = “Hello”
	 myNumber = 10

Notice you have to use quotes (“) to tell 
MAXScript that is a String.

Sometimes you will want to change the variable 
type, and we can do this by defining a new 
variable that takes the value as a different type. 

For example, if I have a number 6 that I want to 
convert to the string “6”, all you have to do is:
	
In the MAXScript Listener, type in the 		
top window:
	 myNumber  =  6
	
This will declare your Integer variable.  When 
you hit Enter, you will notice the value of your 
variable show in the bottom window.

 

Figure 5 – Declaring your first variable
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Now, let’s change the type by typing in the top 
window:	
	 myString = myNumber as string
	
When you hit Enter noticed the value of 
myString is now “6”.

 

Figure 6 – Converting variable types

Now we have two (2) variables with different 
values. You can practice by assigning a different 
value to your already declared variable 
myNumber. Just like before type myNumber = 
and enter a number you want to store there.

If you want to print, meaning you want to see 
what the value is of a variable on the bottom 
window, just type in the top window of the 
MAXScript Listener the command print followed 
by the name of the variable and hit enter like 
this:
	 print myNumber

You will see the value show up on the bottom 
window.

Now, go back to the MAXScript Editor and 
declare a variable that will define what you have 
selected. To trap the value of a selection you 
want to use selection. So this is what your code 
will look like:

sel = selection9.
10.

The name of my variable is sel and its default 
value (the value when I declared it) is selection. 
This means my variable now holds the name 
of the object or objects I have selected in my 
scene.

Arrays

When you have a selection, usually you want 
to do something with that selection. You want 
to use it as a list of things that you are going to 
change in some way. If we want to work with the 
objects in our selection, we need to convert this 
selection into an Array. 

The definition of an array is a group of indexed 
elements. Why indexed? Is like having a list 
where you put each object into a numbered 
space, so we can later call space number 2, and 
we get the object in that space.

To convert our selection to an array you will use 
the same syntax as converting an Integer to a 
string but use “as array” instead. So update your 
line 9 like this:

sel = selection as array9.
10.

Say you want to test what you have written so 
far, you want to evaluate your code. You can 
do this by clicking in the MAXScript Editor... 
Tools > Evaluate All (or Ctrl+E) and this will run 
your code in the current scene. You will notice 
that you can also just evaluate a line or just a 
selection of your code by selecting it and then 
clicking on Tools > Evaluate Line / Selection (or 
Shift+Enter or the num pad Enter).

Create some meshes in your scene, select them 
and Evaluate your code. Say if you created 2 
boxes and select them, once you evaluate your 
code you will get a print out on the bottom 
window of the MAXScript Listener that shows:
#($Box:Box02 @ [-1177.232544,-277.807922,0.000000], 

$Box:Box01 @ [-645.178467,-578.898438,0.000000])

Now you know how to evaluate your code and 
test as you write.
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Conditions

When you write a script, you can make your 
script dynamic by using conditions.  This means 
based on the answer (result or return) to a 
question (condition), your script will execute 
different commands or functions.  Now we get 
into the interesting parts of coding!

One of the most important is the IF statement. 
If your name is Robert, then your Nickname 
is Rob, else (or if your name is something 
else) your Nickname is Guy.  That is how you 
create an IF statement, and how you can build 
conditions into your script.

What happens when you evaluate your code, 
but nothing is selected?  If you look at the 
MAXScript Listener you get #(). What happens 
when you print the value of your variable sel ? 

Remember how we print the value of a 
variable?  You will type in the top window of the 
MAXScript Listener (or in the MAXScript Editor 
and just evaluate that line):
	 print sel

The result, which we can see in the bottom 
window of the MAXScript Listener is:
	 OK

What does this mean?  Well, it’s telling you Ok, I 
can print the value of sel because that variable is 
defined (it has been declared), but it’s empty, so 
I will not return anything. 

To build a good script, and you should look for 
this, we are going to check and make sure the 
user has something selected. If they don’t we 
can warn them to select something. This is how 
you can do that:

if sel.count !=0 then
(
some code we run here
)
else
(
some other code to warn them to select something
)

11.
12.
13.
14.
15.
16.
17.
18.

Breaking down the code you can see that Line 13 
handles the condition: If the selection count is 
not zero, then do something, else do other code. 
Let’s stop and point out two things here. 

First, now that our variable sel contains the 
value for the selection array, sel inherits all the 
properties that an array will have. One of those 
properties is how many elements are in the 
array. Access this property you use the following 
syntax:
	 object.property

The dot gives you access to the property, like 
establishing a relation between a child and 
a parent. And so we can find what the count 
or number is of elements of the array. In this 
example we compare it is NOT equal. These are 
the symbols you will use to compare two values:

•	 Equal		  =

•	 Not Equal	 !=

•	 Greater Than	 >

•	 Greater or Equal	 >=

•	 Less Than	 <

•	 Less or Equal	 <=
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The second thing to notice is the indentation. 
When you write code you need to get in 
the habit of being clean and adding lots of 
comments so that you or someone else can 
come back to that code later and understand 
what each section does. Remember, MAXScript 
evaluates each line at a time. If you need to 
execute multiple lines of code when your 
condition is true, then use parenthesis “( ) “ 
to indicate the beginning and end of a block 
or section of code which needs to happen in a 
specific case.

The last thing we need to do is add the code we 
want to execute when our conditions apply. If 
our selection count is NOT zero, that happens 
when we have something selected, then lets 
print “Hello!” or some other message. If that 
condition does not apply then print “You need 
to have something selected”. Now update your 
code like this:

if sel.count !=0 then
(
print “Hello!”
)
else
(
print “You need to have something selected”
)

11.
12.
13.
14.
15.
16.
17.
18.

Evaluate your script (in the MAXScript Editor 
hit Ctrl+E) and see the results in the MAXScript 
Listener.

You will want to test if you are getting the 
proper count, select multiple objects and try 
to print out how many objects are in the array. 
What do you think would be the proper syntax 
for that line? If print “Hello” is used to print the 
word “Hello”, then to print a variable or a value 
you would use the variable name and no quotes 
like this:
	 print sel

But that will give you the whole array with 
objects. If all you want is that count... I think you 
guessed it! Let’s update Line 15 so you can print 
how many objects are in the array.

print sel.cout13.

Now, select some objects and evaluate your 
code. Test it a couple of times with different 
selections and see how it works. What happens 
when you have nothing selected?

Loops

Sometimes you want to repeat the same 
operation on a series of objects, maybe on an 
array of objects like a selection. For this case, 
you will want to use Loops. Here you will learn 
how to use the most common one: the For Loop.

Like conditions, the for loop will compare to see 
if a condition is true, and if so it will go into a 
block of code. It will continue to repeat running 
that block of code until the condition is false or 
something “breaks” the loop.

The basic syntax for loop is:
	 for obj in sel do
	 ( 
		  do some stuff
	 )

Breaking up the code you can see that for each 
Object (obj) in the array (sel) do some code.

What if you want to loop a specific number of 
times? Then you can write:
	 for i = 1 to 10 do
	 ( 
		  print i
	 )

Now you are temporarily declaring i as a number 
that starts at 1 and will increase 1 every time the 
loop is repeated up to ten times. Once it reaches 
10 it will run the block of code and exit the for 
loop.
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Back to your script, add a for loop that will print 
each of the objects in your selection. This means 
we want to add the loop after we confirm the 
sel.count is not zero. It would look something 
like this:

if sel.count !=0 then
(
	 for obj in sel do
	 (
		  print obj
	 )
)
else
(
	 print “You need to have something selected”
)

11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.

Lines 15 to 18 are very straight forward: you 
are temporarily declaring a variable (obj) which 
will hold each of your array’s elements (your 
selection) one by one as you go through and 
print the value of that variable. 

Again, select (or not) some objects in your 
scene and evaluate your code. You will see 
your objects printing line by line in the bottom 
window of the MAXScript Listener. When the 
script is finished an OK will print to indicate the 
script has finished running with no errors.

As you can see, it’s key to test your script as 
you write it, section by section, to make sure all 
the pieces are executing correctly. You want to 
catch the syntax errors and the bugs when they 
happen, early in the process. If you wait until 
the end to test, you may find yourself debugging 
hundreds of lines of code with no real idea 
where the problem is or where to begin. Keep it 
organized and contained.

Now you have learned the basic structures of 
scripting. With these tools you should be able to 
start learning how to change object properties, 
create tools for enhancing workflow, and 
work with file systems and interact with other 
applications.

In the next section you will learn how to 
manipulate object properties, using functions 
and making user friendly scripts. If you are ready 
for this, here is a little taste of manipulating the 
properties of meshes you have selected.

Let’s add a few lines to your script so your 
code can change any selected mesh into a grey 
shaded object.

Since you are going to change the Wireframe 
color of your mesh and the Meshes color 
(diffuse color), declare variables for those next 
to where you declared the selection variable. It 
should look something like this:

wireColor = [0,0,0] as color   	 -- for WireColor
objColor = [150,150,150] as color   	 -- for Object Color

Remember that color is defined by a vector (3 
numbers) Red, Green, and Blue, or R, G, B, with 
values from 0 to 255. Next, you need to update 
Line 15 so instead of printing the object it will 
change the properties of the mesh. You will 
change the object’s wire color by assigning the 
value of your new variable wireColor to it. Then 
you will add a material to your objects, and 
that material will assign the diffused color you 
defined in your objColor variable.
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Your whole script should look something like 
this:

------------------------------------------------------------------------------------------------
-- CD_GreyShader.ms
-- created 12.03.08
-- by Carlos Dominguez 
-- DESCRIPTION: Simple script to cover basics of: variables, loops, functions
-- 
------------------------------------------------------------------------------------------------
wireColor = [0,0,0] as color			   -- for WireColor
objColor = [150,150,150] as color			   -- for Object Color

sel = selection as array                                              	 -- for Selection

-- Check if there is something selected
if sel.count !=0 then
(
	 for obj in sel do
	 (
    	    -- change wirecolor to black
    	    obj.wirecolor = color wireColor.r wireColor.g wireColor.b

	     -- change material color and apply it to the mesh
	     meditMaterials[24].Diffuse = color objColor.r objColor.g objColor.b
	     obj.material = meditMaterials[24]
	 )
)
else
(
	 print “You need to have something selected”
)

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.
28.
29.
30.

Manipulating Objects in Your Scene

In the last section you learned the basics of 
scripting, and at the end got a taste of making 
a script that yields results in the scene. In 
this section you will learn about functions 
and making your scripts work as a part of the 
working pipeline of Max.

Functions

When you are writing scripts, you need to 
make sure you are efficient and not repeating 
commands or steps when not necessary. You 
practiced this when using a for loop to repeat 
changing the color of each selected object. Now 
you are going to learn how to use functions to 
make your code more flexible and efficient.

A function is a set of commands, almost like a 
mini-script inside a script, which will run every 
time you call this function. Functions usually 
receive values to use inside as variables, also 
called parameters. These parameters are local 
variables that only exist while the function 
is running. Once it finishes executing, the 
parameters no longer exist. Some functions not 
only do something but also return a value (or 
values) that can be used later in the script.

In MAXScript, functions are defined with the 
following syntax:
	 fn funtionName parameters =
	 (
		  Function code
	 )
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Where funtionName is, the name of your 
function and parameters are the name of the 
variables you are going to use. If there is more 
than one parameter you need to separate them 
using spaces like:
	 parameter1 parameter2 parameter3 etc.

Now, let’s convert your main code into a 
function we can use when we need to. All you 
have to do is wrap your IF statement (include 
the selection variable) into your function like 
this:

blk = [0,0,0]
grey = [150,150,150]

fn setColor wColor oColor =
(
	 sel = selection as array                                              -- for Selection

	 wireColor = wColor as color
	 objColor = oColor as color

	 -- Check if there is something selected
	 if sel.count !=0 then
	 (
		  for obj in sel do
		  (
    		     -- change wirecolor to black
    		     obj.wirecolor = color wireColor.r wireColor.g wireColor.b

	     	    -- change material color and apply it to the mesh
	     	    meditMaterials[24].Diffuse = color objColor.r objColor.g 
	 objColor.b
	     	    obj.material = meditMaterials[24]
		  )
	 )
	 else
	 (
		  print “You need to have something selected”
	 )
)

8.
9.
10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.
28.
29.
30.
31.
32.
33.
34.

If you break down the code, you can see our 
function is called setColor and has two (2) 
parameters: wColor and oColor for the wire and 
mesh colors respectively. Also you are redefining 
the variables wireColor and objColor inside 
our function using the parameters as colors. 
This allows you to pass any vector as wColor or 
oColor and your function recognizes it as a color. 
If you don’t do this inside your function, you 
will get an error because the vector won’t be 
recognized as a color.

How do you run your new function? Well 
functions are great because once you define 
them (evaluate the function) you can call them 
anytime you want as long as Max is open. Once 
you close Max, all functions are removed from 
memory, and you need to run them next time 
you open Max if you want to use them. Here is 
how you name a function:
	 functionName parameter

From this example, to run your function you 
need to evaluate your function first. Evaluate 
your whole script, including the two (2) variables 
(blk and grey). Now just type your function into 
the MAXScript Listener top window and hit 
Enter:
	 setColor blk grey
or
	 setColor red blue

If you had something selected, your mesh (or 
meshes) turned black and grey or red and blue. 
How come the second time you ran the function 
you could just type red and blue and not have to 
define those variables? You may have guessed 
that those are reserved words in Max. They 
are pre-defined variables that Max already has 
defined as the red color and the blue color. In 
fact you can use black and gray, which are other 
pre-defined colors. You can always tell which 
words are reserved in the MAXScript Editor by 
the color highlight.
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UI: the User Interface

You learned to add comments to your script so 
other scripters or programmers (or even you 
after a year) can figure out how it works. By the 
same token, when you are creating scripts and 
tools you always want to make sure they are 
easy to use for other people. Here is where the 
User Interface or UI comes into play.

The UI is an integral part of creating proper 
tools whether you are scripting for yourself or 
for others. In MAXScript you create UIs by using 
floaters or windows which contain rollouts. 
There are different types of rollouts you can use 
depending on what you need. In the following 
figure you can see some of the options, which 
you can find under the Help menu by searching 
for Rollout > User-Interface Controls and then 
select the Rollout User-Interface Control Types. 
You can click on the link of the control you want 
to get a description, syntax, and an example for 
the specific control you want.

 

Figure 7 – Rollout Control Types
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To create a UI we need a rollout, which has all 
your buttons and controls that will call your 
functions in your script. Then you will create a 
floater (or window) where you can add these 
rollouts to. The basic code for a rollout looks like 
this:
	 rollout rMyRollout “My First Rollout”
	 (
		  button bMyButton “My Button” tooltip “my Tip of what this button does”

		  on bMyButton pressed do
		  (
			   messagebox “You pushed My Button”
		  )
	 )

The first line defines your rollout with the name 
rMyRollout (I like to start UI elements with 
an initial of what they are: b for button, r for 
rollout, f for floater, etc) and the label “My First 
Rollout”. The label is used as a display text on 
your rollout. Looking into the rollout code block, 
you defined a button called bMyButton with the 
label “My Button” When you hover on top of the 
button it will show a tooltip of “my Tip of what 
this button does”. Next you will establish what to 
do when that button is pressed: a message box 
will pop up and say “You pushed My Button”. This 
“on button pressed do” is also called an event 
handler.

You can test this by creating a new script 
(Ctrl+N) in the MAXScript Editor. Add 
the rollout code, and then after your last 
parenthesis you will create a dialog window to 
show your button, like this:
	 createDialog rMyRollout 150 40

The last two numbers are the dimensions of 
that dialog window (width of 150, height of 40).  
Evaluate your code (Ctrl+E) and check out your 
UI.

 

 

Figure 8 - My first UI

Figure 9 - Message Box
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For your Grey Shader script you are going to 
use two rollout controls: button and colorpicker. 
Back in your script, after the function definition, 
you will add the code for the rollout, like this:

rollout rGreyShader “Grey Wired Mesh”
(
	 button bSelObjects “Selected” tooltip: “Apply grey material with color wire to selected objects”
	 colorpicker cMeshColor “Mesh color:” color:[150,150,150] title: “Choose a color for the Mesh”

	 on bSelObjects pressed do
	 (
		  setColor black cMeshColor.color
	 )
	
	 on cMeshColor changed newColor do 
	 (
		  setColor black newColor
	 )
)

35.
36.
37.
38.
39.
40.
41.
42.
43.
44.
45.
46.
47.
48.
49.
50.
51.

You declared a rollout that has a button and a 
color picker. By now you understand most of this 
code, so let’s focus on the color picker and the 
event handlers for both controls.

Line 39 defines a colorpicker named cMeshColor 
that you are using to define the color you will 
give the mesh. The label is “Mesh Color” and 
you are assigning a default color of grey (RGB = 
150,150,150). Lastly, the title is the label that will 
be used for the pop up window that you use to 
pick the color.

 

Figure 10 - Color Picker

Next you have defined event handlers for the 
button and the color picker (Lines 41 to 49). 

When the button is pressed you call your 
setColor function with parameters black for the 
wire color and cMeshColor.color for the mesh 
color. What is cMeshColor.color? You guessed 
it! It is the current swatch color in your color 
picker.

Let’s go to Line 46 and see what is happening on 
the event handler for the color picker. When the 
color is changed in the color picker, the variable 
newColor will hold that value (the RGB color) 
and the code block will be executed. Now on 
Line 48 you are calling your function to run with 
the same parameters… except instead of using 
cMeshColor.color you are using newColor. We 
have defined our rollout and the event handler 
for it. Let’s create our floater so we can see it in 
action.
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Unlike the dialog box, a floater allows you to 
add multiple floaters and gives you more control 
over the look of it. The standard syntax for 
creating a floater is:

Your new floater will have a label (title) of “my 
n”, will have dimensions of 160 by 90 and it will 
be positioned 10 pixels right and 150 pixels down 
from the top left corner of the screen. To add a 
rollout to the floater you will use:

	 fMyFloater = newRolloutFloater “My floater label” 160 90 10 150

		  addRollout rMyRollout fMyFloater

Let me show you how this looks in your script.

if fGSFloater != undefined then CloseRolloutFloater fGreyShaderFloater
fGSFloater = newRolloutFloater “Grey Shade Mesh” 160 90 10 150
addRollout rGreyShader fGSFloater

52.
53.
54.
55.
56.

You have already learned what is happening on 
Line 54 and 55, but let me tell you about Line 
53. Remember how it is always good practice 
to check for certain things to happen? One of 
them is to make sure your floater does not exist 
in your scene, or if it does then you want to 
close that floater. This allows you to create your 
floater without problems, and avoids having 
multiple windows open with the same thing.

Congratulations, you have written your first 
MAXScript tool!

Evaluate your code and see it in action.

 

Figure 11 - Grey Shader UI

The last thing I want to show you is how to make 
this script easily accessible through the toolbar. 
It’s all about ease of use, so to do this you are 
going to add your script as a button on Max. All 
you have to do is select your code (Ctrl + A) and 
left click and drag it into your toolbar.

 

Figure 12 - Script button

Next time you start Max, that button will still be 
there and you can just click it to call your script.

In this tutorial you have learned the basics 
of scripting; declaring variables, and how to 
use them in your script. You now understand 
the importance of clean, efficient coding and 
the role loops and functions play. You created 
your first tool by adding a UI to your script 
to call your functions. Now you know how to 
use MAXScript to create tools that enhance 
workflow and make art creating pipelines more 
efficient.


